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Town and Village Tutorial

This tutorial will take you through the basic 
techniques I use when creating village 
and town maps in Adobe Photoshop. The 
techniques can also be used to make larger 
city maps though that can become much 
more time consuming.

This tutorial was made using Photoshop 
CS3 on a PC. There may or may not be slight 
differences between earlier and later versions 
with regards to menus and hot-keys! This 
tutorial also assumes a passing familiarity with 
the (very) basic functions of Photoshop.

At a few points I switch to using Paint Tool 
SAI to do some of the linework. This is not at 
all necessary and all linework can be done in 
Photoshop using a hard basic brush at size 1 
or 2. I just prefer the way SAI produces lines.

I do make use of a single texture in the tutorial 
called Just Add Bison which you can find at 
http://www.spiralgraphics.biz/packs/terrain_
lush/index.htm and is quite useful!

The Finished Map

For Adobe Photoshop by Lerb
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Finally, I work using a Wacom Graphics Tablet. Most of the techniques within however are 
procedural rather than artistic and can be done fairly easily with a mouse.
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Part 1: The Basics
Step 1

Start by making a new document. The 
example village is made on an 800x800 pixel 
canvas though I usually prefer 1500x1500 
to give me more space. It all depends how 
ambitious you are feeling.

Double click the top colour swatch on your 
toolbar and set the colour to R:200 G:202 
B:158. Then press Shift + Backspace to fill the 
canvas with the current foreground colour.

Preparing the Texture

Next you need to open your Just Add Bison in 
a seperate document. Then go to:

Edit -> Define Pattern

Call it whatever you wish, then close the 
document. It will now be saved in patterns to 
use in just a moment.

Step 2

Create a new layer and press D to revert your 
foreground/background swatch colours to 
black and white. Then select:

Filter -> Render -> Clouds

In the layers window, set the opacity of this 
layer to about 7 or 8%.

Create a fill/adjustment pattern layer above 
this one. When the box prompts you to select 
a pattern, scroll down to the Just Add Bison 
pattern we added earlier.

In the layers window, change the blending 
mode of the layer from Normal to Soft Light. It 
should now look like the image on the left.

It is advised that you name each of the layers you create as you will be creating many of them 
during the tutorial and it can become a little confusing at times otherwise.
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Step 3

Now on to the roads and water. Create two 
new layers. Name the one at the top Water 
and the one just below it Roads.

Next, take a basic soft brush at a size of 10-
15px. Paint in the dirt road on the roads layer 
(I used colour R:194 G:175 B:111 for the dirt 
road in my example). It doesn’t need to be 
perfect right now as it’ll probably see some 
minor changes once we start putting in the 
buildings. It is just to give us our basic road 
layout.

Do the same with the water on the water layer 
(using colour R:115 G:155 B:200 or whatever 
you prefer).

In the example I opted for a cross-shaped 
road layout with a small river running beside 
the village. You can also add in small ponds 
and lakes if you so choose.

Part 2: The Buildings
Step 4

Create a new layer above the rest and call 
it buildings. Now select the Line Tool (hit U) 
and make sure the anti-alias box at the top is 
checked.

Set the width to between 30-45 pixels and 
simply draw in lines for your buildings. Vary 
the line width for narrower or wider buildings 
as desired and combine lines to create 
different shapes.

I use a terracotta colour (R:226 G:161 B:126) 
for tiled roof buildings, a yellow-brown (R:227 
G:203 B:128) for thatched or wooden buildings 
and a dark brown (R:182 G:165 B:130) for 
wooden shingled buildings but you should 
experiment to find colours you prefer.

Right now it doesn’t look like much but it will 
in just a moment.
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Step 5

Double click the thumbnail image for the 
buildings layer in your layers window to open 
the Layer Styles window. First select Drop 
Shadow and set the details to:

Blend Mode: Multiply, Opacity 75%, Angle 
120 (make sure use global light is checked), 
Distance 4px, Spread 0%, Size 5px.

Next select Stroke. Set the colour to Black, 
Opacity to 100%, Position: Centre, Size 3px 
and the Blend Mode to Normal.

Step 6

Hold Ctrl and click the building layers 
thumbnail to select only the items (the 
buildings) on that layer. Then select the Line 
Tool (U) set to a width of 3px and draw in the 
roof peaks. Don’t forget to draw in the corners 
where peaks meet.

Because you selected the buildings only, you 
don’t have to worry about drawing over the 
edge of the buildings either.

Some might find the 3px building stroke a bit much, especially if your buildings are generally smaller 
overall. In this case just use a 2px stroke instead. Remember to set the roof peak lines to match as well.

Step 7

Now to shade the buildings. With only the 
buildings still selected, take a hard round 
brush with the blend mode in the tool options 
at the top set to Darken.

Hold Alt and click the roof of a building to 
select its colour, then in your colour options, 
select a darker version of that colour.  Paint in 
the shadowed slopes of your roofs (the dark 
blending mode ensures you won’t paint over 
your roof lines), keeping the light direction 
consistent (use the position of your drop 
shadow as a reference).
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Step 8

It’s time to add some detail to the buildings! 
At this point I load the image into Paint Tool 
SAI and use a 1.5px pen brush to sketch in the 
details because I find it produces much nicer 
lines. However for the purpose of this tutorial, 
we shall stick with Photoshop.

Again, keeping only the buildings selected 
on the buildings layer, take a black 1px hard 
brush. If you’re using a tablet, set Opacity and 
Flow to Pen Pressure in the Other Dynamics 
part of the Brush Options window as indicated 
on the right.

Also make sure that you have set your brush 
blending mode back to Normal from Darken.

If you’re using a mouse, this part could prove 
a little tricky.

Draw in short strokes along the buildings. 
Don’t overdo it - less is more. Add smaller 
lines crossing them in places to give a sense 
that they are tiles. Alternatively, use consistent 
straight lines running down the slope of the 
roof to make it seemed thatched or planked.

You can vary the style of your lines to get 
different looking roof styles. This part is 
a little more artistic and it’s more about 
experimenting and finding what you like.

You can even add large black spots to give a 
sense the building is a bit run down with some 
holes in it.

The roof doesn’t have to be all one colour 
either. You could take a low opacity (15-20%) 
soft green brush and make it look a little 
mossy or add other details.

This part can be pretty fun (or really tedious 
on huge maps). When you’re done, your 
buildings should look something like those to 
the left.
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Part 3: Land Contours

I often see questions about this come up quite 
a lot. People want to add a sense of elevation 
to the terrain but doing so can prove a little 
tricky. Fortunately, I developed a quick, easy 
and effective way of doing just that.

Step 9

Create a new layer between your Roads Layer 
and your Water Layer and name it Contours. 
Double click the layer in the layers window to 
open the Layer Styles window.

Select Bevel and Emboss and use the options 
indicated in the image on the right then click 
OK. In the layers window, set the FILL for this 
layer to 0%.

Take a large soft brush (doesn’t matter what 
colour) with the opacity set to about 20% and 
paint where you want your hills to slowly rise 
up. You will notice that no colour appears on 
the canvas, but the layer style effects do show 
up (this is because the Fill is set to 0%).

Optional: Stronger Contours

Using the above gives you shallow falls and 
rises, but sometimes you want harsher or 
larger hills and embankments, or steep sides. 
The first option to achieve this is to simply 
stack one or more contour layers on top of 
each other.

The other option is to create a new layer on 
top of the contours layer and simply paint in 
shadows with a soft black low opacity brush.

I tend to prefer the latter option (as I have 
done in the example image) but it’s worth 
experimenting with it a bit to find what fits 
best.
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Part 4: Walls, Fences and 
Bridges

Step 10

Adding fences and walls is much like drawing 
in the buildings, only the layer style options 
are slightly different.

Create a new layer just below the buildings 
layer and open the Layer Styles window.

Select Drop Shadow. Set Blend Mode: 
Multiply, Opacity 75%, Angle 120 (make sure 
use global light is checked), Distance 3px, 
Spread 0%, Size 5px.

Next select Stroke. Set the colour to Black, 
Opacity to 100%, Position: Outside, Size 2px 
and the Blend Mode to Normal.

Pick a brown colour, select the line tool (2px 
width) and just draw in where you want your 
fences to be. For small stone walls, I use a 
slightly wider mid-grey line.

Step 11-13

Create a new layer just above the Water (but 
below Fences) layer and call it Bridge. Use the 
Line Tool (U) and a brown colour to draw your 
bridge across the river. Open the Layer Styles 
window and give it a 2px centered Stroke.

In much the same way as with the buildings, 
use a 1px black brush to add planking detail 
to the bridge (don’t forget to Ctrl + Click the 
layer to select only the bridge so you can’t 
draw beyond it).

Now create another new layer just above this 
one and call it “Dirt”. Use a soft low opacity 
(10-20%) brush the same colour as your road 
and brush over the ends of your bridge. Add a 
little dirt to indicate foot traffic too.

Finally, on your fences layer, use the line tool 
to add railings to your bridge. The fences layer 
can be useful for little details like this.
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Part 5: The Road and River

Step 14

Well it’s starting to look a little better but 
the water and roads need a little work. We’ll 
accomplish this using a mix of layer styles and 
artistic license.

We’ll start with the roads. Double click your 
roads layer to open the layer styles window. 
We’re going to add an Outer Glow and a Bevel 
and Emboss style.

Click Outer Glow. Set the Blend Mode to 
Multiply, the Opacity to 35% (leave Noise at 
0%). Pick a mid-grey colour. Set the technique 
to Softer, the Spread to 3, Size 16px, Range 
51%, Jitter 0%.

Now Select Bevel and Emboss. You want an 
Inner Bevel set to Chisel Hard, Depth 100%, 
Direction: Down, Size 1px, Soften 0px.

Set the highlight opacity to 25% and the 
shadow opacity to 40%. Click OK.

Ctrl + click the layer to select only the road. 
Take a dark brown soft brush set to a low 
opacity (10-15%) and darken the middle of 
the roads slightly to suggest the movement of 
people and carts. Don’t overdo it though.

Now to give it a bit of texture. Select:

Filter -> Texture -> Texturizer

I use a custom texture for this but the default 
sandstone one will suffice. Set the relief to 1 
or 2 (remember - less is more!), the scaling to 
50% and the Light to Top and click OK.

Your road should now have more defined 
edges, a bit more variance and also have a 
subtle texture to it.

Don’t forget to repeat the shading and texture 
effect on the dirt for the bridge earlier (but 
don’t add any layer styles) so they match up.
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Step 15

To the water we are going to add an Outer 
Glow and an Inner Glow. Select your water 
layer and open the Layer Styles Window.

Select Outer Glow, choose a very dark blue, 
almost black colour. Set the blend mode to 
Multiply and the Opacity to 50%. Set the 
Spread to 6%, the Size to 18px and the Range 
to 84%.

Under Inner Glow, again choose Multiply and 
set the Opacity to 45%. Choose a dark blue 
(R:19 G:48 B:82), set the Source to Centre, the 
Choke to 19%, the Size to 73px and the Range 
to 62%.

Step 16

Now to give it a bit more flow. Ctrl + Click 
your water layer and take a small soft low 
opacity (10-15%) white brush and sketch in 
ripples, waves and such. Note where it catches  
rocks or the beams from buildings, jettys or 
bridges to enhance the sense of flow.

Add more white where it is particularly choppy 
or picks up speed. You may wish to draw 
in rocks on a separate layer if you want a 
particularly treacherous river.

Step 17 - Optional: Non-Blue Rivers

Blue is a classic choice but rivers don’t 
always look blue ( just look at google maps 
for example - they can vary quite a bit.). 
I’ve been experimenting with more natural 
colours and it can be fun to try that out. Also, 
you might want a slightly polluted river or 
maybe something more fantastic. To do that, 
just follow the above, only change the base 
colours to suit.

Also if you are drawing a night-time map, 
remember that the water is going to look 
almost black as it is reflecting the night sky.
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Part 6: Trees and Foliage
Step 18

This is where a tablet pen really comes in 
handy. There are a number of ways of drawing 
trees and the like but I shall go with the most 
recent technique I have employed. Again, I 
switch to SAI for this, but it can easily be done 
in Photoshop too.

On a new layer above everything else (call 
it Tree Outlines), take a 2-3px hard brush at 
100% opacity and sketch in the outlines of 
trees. Most trees generally stand higher than 
the buildings and such around them, so don’t 
be afraid to draw over everything else ( just 
remember that the trunks have to meet the 
ground at some point!).

Step 19

On a new layer just below this one (called 
Tree Colour), paint in the colour of the trees 
with a larger hard brush. Vary your colours 
a little (trees are varied, also you may want 
to reflect the season). It can be fun to add 
cherry blossoms and the like as in the example 
image.

Step 20

Now they need a little depth. First we can 
add a 5px drop shadow using the Layer Styles 
window, but they still look a little flat.

Ctrl + Click the Tree Colour layer to select 
only the trees, then take a large, low opacity 
soft or grungy brush. Select a lighter green 
(or whatever is appropriate) and paint in the 
highlights. You can be quick and messy. Do 
the same for the shadows.

If you think you have overdone it, you can 
always go to:

Image -> Adjustments -> Brightness/
Contrast OR Hue/Saturation

Simply play with the options until it looks 
how you want it (It will only affect the current 
active layer).
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Part 7: Details
At this point we’re pretty much done but there 
are all kinds of little additions you can make.

Chimneys

While they might seem a pain to add at first, 
it’s surprisingly simple. Just make a new layer 
with a 2px black (outside) Stroke Layer Style 
and a 3px Drop Shadow. Then add a black 
Inner Glow with Blend Mode set to Normal, 
Opacity 100%, Choke 10%, Size 3px, Source: 
Centre, Range 17%.

Take the Line Tool (U) with a width of 4-6px 
and just draw in small lines. To add smoke, 
use a soft, low opacity (10%) white brush on a 
layer just above it.

Flowers

Flowers can be achieved by using a small basic 
brush (1-2px) set to 60% or so opacity. In the 
brush options, increase the spacing under 
Brush Tip Shape and add some scattering.

Then just paint them in with a vibrant red or 
blue or such.

Objects

You can add things like crates, barrels and 
tables by just using the Line Tool (U) or one of 
the shapes tools on the Fences layer or a new 
layer with similar layer style properties. They 
don’t need much detail as they will be pretty 
small anyway. If you wish to give them the 
appearance of stacking, using additional layers 
on top.

Something to Note

Combining a stroke layer style with the Line 
or Shapes tool gives smooth edges. But if you 
use the hard basic brush, it looks a bit wider 
and more ragged. To get around that, Use 
Filter -> Sharpen -> Smart Sharpen to clean 
up the edges of objects drawn using a brush 
(Remember to select only that you wish to 
sharpen).
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Part 8: Colour Schemes
The example map uses a fairly bright and 
vibrant colour scheme but you are by no 
means restricted to that. The pallet you pick 
will set the mood and the overall impression 
of the environment. I have used the 
techniques above with a variety of different 
schemes as you can see below:

A village in a fairly hot and dry place.

A lonely fortified village deep in the woods.

A tropical port town.

A dreary windswept town.

So experiment and have fun. I hope my 
tutorial was useful. It is by no means the way 
to do things of course, just the way I do them.


